
 
 

Student Technology Services 
provides AASU students a wide 
range of technology resources, 
services, and information, so 
students are able to incorporate 
technology into their learning 
environment and course work.  
 

Student Help Desk 
provides in-depth phone and 
email technical support and 
resources to students regarding 
WebCT, Microsoft Office 
programs, and student email.  
 

Computing Labs  
are provided in MCC Annex and 
UH 112 for students to use to 
complete academic course work.  
 

Orientations/Workshops  
are now offered regarding 
WebCT, computer and Internet 
basics, and Microsoft Office 
programs.  Students are 
encouraged to visit 
www.sts.armstrong.edu to view 
an updated schedule of 
orientations and workshops.  
 

 

Macromedia Dreamweaver 4.0  
 

Learn how to design and create a web site 
using Macromedia Dreamweaver 4.0. 

 

ü Learn web design fundamentals  

ü Link web pages to internal and 

external web pages  

ü Change the background color of a 

web page  

ü Create text and image hyperlinks  

ü Create email hyperlinks  

ü Create and format a table  

ü Add graphics to a web page  

ü Preview your web site in a browser  

 
CONTACT STUDENT TECHNOLOGY SERVICES: 

www.sts.armstrong.edu 
 

STUDENT HELP DESK 
912.927.5321 

Toll-free 1.866.533.6353 
techhelp@mail.armstrong.edu 

http://www.sts.armstrong.edu/helpform.html 
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WWeebb  DDeevveellooppmmeenntt  UUssiinngg  MMaaccrroommeeddiiaa  DDrreeaammwweeaavveerr  
 
Macromedia Dreamweaver is a powerful web site building program. It allows you to create web sites 
with little to no knowledge of HTML. Dreamweaver is well-known for its clean coding of web pages. 
Before you use Dreamweaver, you should have a basic understanding of web design and development. 

 
What is HTML? 

 
HTML is an acronym for HyperText Markup Language, the programming language used to create 
web pages. HTML enables you, the designer, to create hypertext links to other HTML files and also 
allows you to include static and interactive graphics, video, and sound files in your document; this is 
done by inserting special strings of characters, called HTML tags, into your document. These tags 
control the structure and behavior of the text or the bits of information to be displayed. Most HTML 
tags have an opening and closing tag; the closing tag is indicated by a forward slash ( / ). The HTML 
syntax comprising the tag is surrounded by a less than and greater than symbol ( < > ). 

<font size="+3"> This is text in a larger font size.</font> 
 

 
 Figure 1: Notepad HTML code 
 

What is a web authoring, or editing, program? 
 
A web authoring program is like a desktop publisher or word processor, allowing you to simply type 
on a document and use menus and shortcuts to apply formatting. Additionally, a web authoring 
program enables you to produce web pages, or HTML files, that can be visible on the web. 
 
Examples of web authoring programs: 
   

• Macromedia Dreamweaver 
• Microsoft FrontPage 
• Adobe PageMill 
• Corel WebSite Builder  

• Netscape Composer (free) 
• 1st Page 2000 (free) 
• WebPlus (free) 
• HTML-Kit (free) 
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Figure 2: Macromedia Dreamweaver 4.0  Figure 3: Netscape Composer 7.0   

 
Advantages and Disadvantages: 

Web Authoring Programs and HTML 
 
Table 1: Web Authoring Program vs. HTML 
Editor Advantages Disadvantages 
 
 
 
Web Authoring 
Program 

• Text can be typed directly and 
formatted similar to how you would 
do in a word processor.  

• Images are readily imported into the 
program, and hyperlinks to other 
files or external sites are easy to 
implement. 

• Tables and frames can be created 
easily.  

• The programs usually report broken 
hyperlinks and have spell and/or 
grammatical checkers.   

• The better ones are expensive and 
the user still has to learn how to use 
their features and menus.   

• It can also be annoying to discover 
that a page, carefully arranged in an 
authoring package, does not display 
exactly as intended when viewed via 
a browser.  

 
 
 
HTML Code 

• Readily and cheaply available; can 
use a text editor, such as Notepad, 
and a browser, such as Netscape or 
Internet Explorer 

• An extensive range of HTML tags 
and attributes need to be 
remembered or constantly referred 
to, along with the correct syntax for 
their use.  

• Errors in HTML can sometimes be 
quite difficult to find and may 
require considerable searching in the 
text editor to fix them.  

• It is a repetitive and slow process to 
constantly switch between the text 
editing program and the browser 
program.  
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Getting Started with Web Design 
 

According to Asha Dornfest, author of FrontPage 2000 for Dummies, there are five steps to a 
brilliant web site: 
 
1. Give your site purpose. Focus on what you want your site to accomplish. After you decide 

what you want your site to do, make the purpose clear to your visitors right away so they 
know what to expect if they decide to stay for a while. 

 
2. Remember your visitors. In order for you to establish an effective purpose, you must 

concentrate on your target audience. Try to visualize how old they may be, what type of 
hobbies they may have, and what type of language they may use (slang, proper English, etc.). 

 
3. Cultivate an image. Think about how you want your target audience to describe your site— 

“friendly,” “cutting-edge,” “useful,” “bizarre”—and choose your site’s graphics and layout 
accordingly. 

 
4. Make your site easy to navigate. Always guide your visitors with clearly categorized 

information and thoughtfully placed links. Navigation bars will be a great help to your 
visitors also. Keep pages short and easy to read. If your visitor gets lost, give them a map 
containing links to all the pages in your site. You could also set the site up so that visitors can 
search your site for keywords (this can be done using the FrontPage Search Form 
Component). 

 
5. Plan for the future. As time goes on, you are bound to add new pages and even new 

sections to your site. However, it is very important that you keep the growth of your web site 
in perspective by refining the purpose of your site and by remaining focused on your 
audience. 
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AASU’s Web Design Tips 
 
1. Because many users view their monitors at an 800 x 600 resolution, it is best to design at this 

resolution setting. 
 
2. Web pages should be easy to navigate and have links, so users can easily navigate back to 

secondary pages or the home page. 
 
3. Ideally, users should not have to scroll down or across the web page. 
 
4. Text should be large enough for users to read the information provided without eye strain. 

The default font size is "3" for normal text.  
 
5. Graphics used on pages should have manageable file sizes (e.g. less than 30 K, if possible). 

Certain graphics such as photos may exceed this size; however, every effort should be made 
to keep file sizes of graphics small. Smaller graphics mean less download time, which helps 
the user. 

 
6. Black backgrounds with lightly colored or white text should not be used as text on pages of 

this type does not appear or appears faintly when web pages are printed from the browser.  
 
7. If a page must incorporate large amounts of text, bookmarks or anchors may be used to 

prevent the user from scrolling and to assist in quick and efficient navigation of the page. 
 
8. Frames should be avoided as a design approach since this format is not, in general, ADA 

compliant and often confuses rather than assists users in navigating a web site.  
 
9. Another ADA-related suggestion is to label graphics with <alt> tags for those with screen 

reading software so that particularly navigational graphics can be interpreted for the student 
with special needs.  

 
10. Links to other pages, external web sites, and those that send email (i.e. mailto:) should be 

designed with adequate description so that a screen reader can interpret the link correctly. In 
other words, avoid creating links that say “Click here”; instead use phrases, such as 
“Download the Acrobat Reader.”  

 
11. It’s useful to include a “Last modified” date on your page. 
 
12. Keep the design of the web site consistent. 
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Simple Beginnings 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Homepage or 

Index 

Plan Your Web Site! 
 

1. Organize/Map Your Ideas 
Before you start creating your web site, plan the 
structure and organization of the site, from your 
home page to all of your site’s links. The 
illustration to the right is an example of how you 
can begin planning. This is practical if your page 
is not going to be complex. 
 

2. Bookmark Sites 
If you plan to link to other web sites, you should 
find them and bookmark them in advance. This 
will save you time during the development phase 
of the web site. 
 

3. Find and Save Graphics 
You will also save time by having all of your 
graphics saved in your web folder before you 
begin your web creation. Ideally, these graphics 
should be in GIF or JPEG format. 

 

Link from Homepage 
 
 
 
Introduction 
 
 
Paragraph 1 
 
Paragraph 2 
 
 
Section 2 
 
Paragraph 1 
 
Paragraph 2 
 
 
Section 3 
 
Paragraph 1 
 
Paragraph 2 
 
 
Go to Top 
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Plan Linked Pages 
 
  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Homepage or 
Index Page 
 

Introduction 
 

Topic 1 
 

Topic 2 

Introduction 
 
Idea 1 
 

Idea 2 
 

Idea 3 

Topic 2 

Idea 1 

Idea 2 

Idea 3 
Topic 1 

For more complex sites, you will want to plan how you will 
organize your ideas on separate pages. Some pages may just 
contain links to many other pages. On each of these pages, you 
will want to define your navigation scheme. You may want to 
use a navigation bar on the top or side of the page. In addition to 
a navigation bar with default links, you will also need to 
determine if a page will need to link to any other related pages. 
 
Make these decisions before you begin your web site. 
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Creating Pages Using Dreamweaver 4.0 
 
The Dreamweaver environment includes a collection of floating palettes; the two most basic and 
important are the Property Inspector and the Object Palette. The floating palettes (Object 
Palette, Launcher, and Property Inspector) may appear in different positions to those shown in 
Figure 4. It is possible that occasionally they will be “floating” outside the Dreamweaver 
document window. If you don’t see one or all of them, go to the Window menu at the top of the 
screen and select the palette you wish to appear. You can move each palette by “grabbing” it 
with your mouse and placing it where you wish. 
 

 
 Figure 4: Dreamweaver Interface 
 

Property Inspector 
 

 
Figure 5: Property Inspector 

The Property Inspector displays properties for selected objects. Text properties 
include font type, font size, link/URL, text color, etc. Other properties provided 
in the properties inspector are specific to the element selected such as image 
(size, alt tag, etc.) and table (number of rows and columns, border, etc.) 
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The Objects Palette 

The Objects palette contains the following panels:  
• The Common panel contains the most commonly used objects, such as Image, Table, and 

Layer. 
• The Characters  panel contains special characters such as the copyright symbol, curved 

quotation marks, and trademark symbols. (Note that these symbols may not display 
correctly on browsers other than Netscape Navigator 3 and 4 and Internet Explorer 3 and 
4.) 

• The Forms  panel contains buttons for creating forms and form elements. 
• The Frames panel contains common frameset structures. 
• The Head panel contains buttons for adding various HEAD elements, such as META, 

KEYWORDS, and BASE tags.  
• The Invisibles panel contains buttons for creating objects that are not visible in the 

Document window, such as named anchors. Choose View > Invisible Elements to display 
icons that mark the locations of these objects. Click invisible-element icons in the 
Document window to select the objects and change their properties. See About invisible 
elements. 

 
The Specific Icons on the Objects Palette 

Common 
The Common panel in the Object palette contains the most commonly used objects:  
 

 Image Places an image at the insertion point. A dialog box appears so that you can specify 
an image file and some properties of the image. 

 Rollover Prompts you to specify two image files that are used to define a rollover. A 
rollover is an image that changes when the pointer moves across it.      

 Table Places a table at the insertion point and allows for customization of that table (cells, 
columns, rows).  

 HR Places a horizontal rule at the insertion point.  

 Navigation Bar Inserts a set of images to be used for navigating through a site and helps 
determine links to other pages or web sites.  

 Layer Creates a layer. Click the Layer button, then move the pointer to the Document 
window and drag to define the size and location of a layer. Layers can be used to place 
information on top of other information or hide information and attach them to button 
behaviors. 

 Line Break Places a line break (<br>) at the insertion point. You can also press Shift+Enter 
(Windows) insert a line break. This appears as a single space as opposed to a double space 
that you get when you press Enter. 

 E-Mail Link Places an e-mail link at the insertion point. You type in the hyperlinked text 
and your email address.      
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 Date Places the current date at the insertion point. A dialog box appears in which you can 
specify a format for the date and indicate whe ther Dreamweaver should update the date 
automatically every time you save the file.  

 Flash Places a Flash movie at the insertion point using the OBJECT and EMBED tags. See 
Flash movie properties in the Dreamweaver help menu for more information. 

 
Characters 
The Characters panel in the Object palette contains some special characters:  
 

 Copyright Places a copyright symbol at the insertion point.  

 Registered Places a registered-trademark symbol at the insertion point.  

 Trademark Places a trademark symbol at the insertion point.  
 
Head 
The Head panel contains objects for adding elements to the HEAD section of your documents. 
You will probably not use these objects very often as they add information to the source code of 
your document and do not change the functionality. However, you may find the Keyword icon 
useful if you want your web site more accessible through search engines. 
 
Invisibles 
The Invisibles panel contains buttons for creating objects that are not visible in the Document 
window.  Choose ViewàInvisible Elements to display icons that mark the locations of these 
objects. Click the icons to select the objects and change their properties.  
 

 Anchor Places a named anchor (<a name="">) at the insertion point. A dialog box appears; 
enter a name for the anchor. For more information about creating and using Anchors refer to 
your Dreamweaver help menu and the “Linking to a named anchor” section.  

 NBSP Places a non-breaking space (&nbsp;) at the insertion point. (A non-breaking space 
prevents a line break from occurring between two words.)  It also inserts extra spaces (much like 
pressing the space bar in word processing. 
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Beginning a New Page 

1. From the File menu, select New.    
2. Make sure that the following palettes are displayed: the Properties Inspector and the Object 

Palette. If not, go to Window and select Objects and Properties. 
 
Changing the Background and Title of Your New Page 

In the Document window select Page Properties from the Modify menu. The following dialog 
box will appear.  
 

 
 Figure 6: Page Properties 
 
The Title field allows you to type in a title for your page (e.g. My Page). This title is what 
appears in the title bar of a web browser. 
 
The Background Image field allows you to browse for and select a background image for your 
page. If you choose not to have a background image, you can opt to change the background color 
of the web page. 
 
The Background color box allows you to select a color for the background of your page. 
 
The Links and Visited Links color boxes allow you to select colors for your links, included the 
ones that have been visited. 
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Saving Your Home Page 
 
You should save your home pages as index.html. 
 
Why index.html? Name your home page index.html to make it easier for browsers to find your 
page. If you do not name your home page index.html, then browsing for 
http://www.<yourwebsite>.com will display a directory listing of all your uploaded files, rather 
than your home page. 
 
index.html is usually the default page that loads, so if you name your home page index.html, then 
you should not need to specify it in the URL. 
 
In other words, http://www.armstrong.edu = http://www.armstrong.edu/index.html  
 

Inserting Graphics on a Web Page 
A note about links, graphics and paths: 
To reduce confusion, place all of your pages and images in the same folder. If you have a larger 
site and wish to soft your files into folders or directories, make sure the directory structure on 
your local computer (e.g. hard drive) mirrors exactly the directory structure on your virtual space 
on the server. This helps to maintain the integrity of the path to your pages or images so that 
when you publish via FTP, your pages will appear correctly.  If you don’t do this you may end 
up with an incorrect path and your page will not display properly. Also, a good rule of thumb to 
follow is to make sure that before you insert graphics in your page, you have saved your html 
document (web page) in the correct location on your hard drive. 
 
 INCORRECT CORRECT 

    Figure 7: Incorrect Path Figure 8: Correct Path 

 

How to Insert a Graphic: 

1. Go to InsertàImage or click on the image icon (picture of a tree) on the Objects 
Palette. Remember the concept of paths applies to images also!! 

2. Locate your image and click Select. 
3. Check the path of your image in the SRC field in the Property Inspector. 

 

 
 Figure 9: Check the Path via the Property Inspector 
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Creating Links 

The following information will help understand how to link to: (1) URLs (addresses on the 
WWW), (2) other documents in your web site, and (3) links to send an email. 
 
How to Create Links: 

1. To create a link to a URL on the web: 
 

a. Select text or an image that will serve as your hyperlink. 
b. Go to the Property Inspector window and type the URL (web address) in the Link 

field. NOTE: Make sure you type in the complete address including http:// at the 
beginning of the URL. 

 
2. To create links between documents: 

 
a. Select text or an image in your web page that will serve as your hyperlink. 
b. Go to your Property Inspector (Window > Properties) and do 

one of the following: 
• Click the folder icon to the right of the Link field to browse and select a file. 

The path to the linked document appears in the URL field. 
• In the Link field, type the path and file name of the document. 

 

 
 Figure 10: Typing the Link’s Path 

How to Create Email Links: 
 
To create email links: 
 

1. Highlight the text or graphic you want to link. 

2. Select the email icon  from the Objects Palette (or go to InsertàEmail Link). 
3. Type the email address and select OK. 

 
Note: You can also type your email address in the Link field in the Property Inspector. But you 
must type mailto: prior to your email address. Example: mailto:name@yahoo.com  
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How to Insert Rollover Images/Links: 
 
A rollover image changes to a different image when a user mouses over the image. Often, 
individuals use rollover images for links. 
 

1. Go to InsertàInteractive ImagesàRollover Image. Or select the “Insert Rollover 

Image” icon  from the Objects panel under “Common.” 
2. Select the “Browse” button for the Original Image. 
3. Find and select the image that should appear on your web page. 
4. Select the “Browse” button for the Rollover Image. 
5. Find and select the image that should appear when a viewer mouses over the original 

image. 
6. If you leave “Preload Rollover Image” selected, then your rollover image will be 

downloaded before a user mouses over the original image (preventing delay). 
7. In the “When Clicked, Go To URL” box, type the entire web address for the link. (If 

you’re referencing a page you created, make sure there is no reference to your hard drive 
or any other drive.) 

 

 
 Figure 11: Insert a Rollover Image  
 

How to Create Links Within Documents (these are called named anchors) 

Named anchors set position place markers in a document (they are also called bookmarks and 
targets). Named anchors are often used to link to a specific topic on the page or back to the top of 
a document. Creating a link to a named anchor is a two-step process. First, you will create a 
named anchor; second, you will create a link to the named anchor. Note: Named anchors are 
case sensitive. 
 

To create a named anchor: 
 

1. In the Document window, place the cursor at the point at which you want the named 
anchor (next to an image or bit of text).  

2. From the Insert menu, choose Named Anchor or choose the anchor symbol from the 
Invisibles menu on the Objects Palette. 

3. In the Anchor Name  field, type a name for the anchor.  
4. If the anchor icon/marker doesn't appear at the insertion point location, choose View > 

Invisible Elements 
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To link to a named anchor: 
 

1. In the Document window, select text or an image to create a link to your named anchor.  
2. In the Link field of the Property Inspector, type a number sign (#) and the name of the 

anchor. For example: To link to an anchor named "top" in the current document, type 
#top. Remember anchors are case sensitive. 

3. If you’re feeling adventurous, you can also try the point and click method. Highlight your 
link (text or image) and point with your mouse to the symbol next to the file folder in the 
Property Inspector window that looks like a compass . Holding your mouse down, 
drag to the anchor symbol and release the mouse. Your named anchor has been set. 

 
How to Create Tables: 
 
To create tables: 
 

1. Place your cursor where you would like to insert a table. 

2. Select the table icon  from the Objects Palette (or select InsertàTable). 
3. Specify the number of rows and columns you want for your table. 
4. Specify the width of your table in pixels or percent. 
5. Specify the size of the border. If you don’t want a border, type “0.” 
6. Specify the size of the cell padding and cell spacing. 

Cell padding: the distance between the text and the cell border 
Cell spacing: the distance between the cells 

7. Select OK. (You can change all of these settings later through the Property Inspector.) 

Some more important information about paths: 
 
Document-relative paths  are the most appropriate paths to use for internal links in most Web 
sites. They're particularly useful when the current document and the linked-to document are in 
the same folder and are likely to remain together. You can also use a document-relative path to 
link to a document in another folder by specifying the folder hierarchy in the path. 
When you specify a document-relative path, you leave out the http:// segment of the web 
address. You don't need this if the web pages are in the same folder in a virtual space, for 
instance. 
 

• To link to another file in the same folder as the current document, simply provide the file 
name to which you wish to link (e.g. linking from the index.html file to the classes.htm file 
you would type simply classes.htm in the Link field in your Property Inspector window). 

• To link to a file in a subfolder of the current document's folder, provide the name of the 
subfolder, then a forward slash, and then the file name to link to (e.g. images/ginger.jpg). 
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For example, suppose you have a site with this structure: 
 

 
Figure 12: File Management 
 

• To link from contents.html to hours.html (both files are, in the same folder), you would 
type hours.html in the Link field. 

• To link to tips.html (in the subfolder named resources),you would type 
resources/tips.html in the Link field. 

• Each forward slash (/) represents moving down one level in the folder hierarchy. 
• To link from contents.html to catalog.html (in a different subfolder of the parent 

folder), type the path ../products/catalog.html. 
• Each ../ represents moving up one level the folder hierarchy. NOTE: This concept is the 

same when inserting images 
 

NOTE: An incorrect path is the most common source of broken images and pages not 
found on web sites. 
 

How to Publish a Web Site: 
 

Free Web Publishing Services: (To find more, type “free web publishing” in a search engine.) 
 

Tripod  http://www.tripod.lycos.com/ 
Angelfire http://www.angelfire.com 
TopCities http://www.topcities.com/ 
ProHosting http://free.prohosting.com/ 
 
Your ISP: Often Internet Service Providers offer server space for their customers to upload web 
pages. Contact your ISP to see if they offer this service. 
 
AASU: If you are completing an academic web project, a faculty member can publish your web 
pages to Armstrong’s web server or direct you to another faculty or staff member who can. 



Web Development Using Macromedia Dreamweaver 

Last modified: 2/25/2003 16

Web Resources: 
 
There are many free resources on the web to build web pages. You can access fonts, background 
images, button graphics, and tutorials, to name a few. 
 
Free Fonts: 
 
http://www.fontfreak.com 
 
Background Images: 
 
http://www.free-backgrounds.com 
http://www.marketwizz.com/backgrounds/ 
http://www.victoriaring.com/business/training/graphics/backgrounds/ 
http://www.ip.pt/webground/main.html 
 
Buttons and other graphics: 
  
http://wow.buttons4free.com:82/buttons.htm 
http://www.geocities.com/SoHo/Lofts/4165/ 
http://www.stewartstudio.com/button1.htm 
http://www.wbshp.com/freebuttons.html 
http://www.andyart.com/files/freebies/ 
 
HTML tutorials: 
 
http://www.davesite.com/webstation/html/ 
http://werbach.com/barebones/ 
http://www.webmonkey.com 


